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Product Description

Polyspace® UML Link™ RH software extends Polyspace Client™ for C/C++
and Polyspace Server™ for C/C++ products with tools that let you trace
Polyspace results from generated C++ code directly to your IBM® Rational®
Rhapsody® models. As a result, you can identify parts of the model that do
not generate code with run-time errors, and fix design problems that cause
run-time errors. You can verify a mix of generated and hand-written code
before it is compiled.



Code Verification Approach

Code Verification Approach

In a collaborative Model-Driven Development (MDD) environment, software
run-time errors can be produced by either design issues in the model or faulty
handwritten code. You may be able to detect the flaws using code reviews
and intensive testing. However, these techniques are time-consuming and
expensive.

Through Polyspace UML Link RH software, you can apply Polyspace
verification to C, C++ and Ada code that you generate from your IBM
Rational Rhapsody model. As a result, you can detect run-time errors and
automatically identify model flaws quickly and early during the design
process.

For information about installing and using IBM Rational Rhapsody, go to
www-01.ibm.com/software/awdtools/rhapsody/.

The approach for using the Polyspace UML Link RH add-in within the IBM
Rational Rhapsody MDD environment is:

® Integrate the Polyspace add-in with your Rhapsody project. See “Adding
Polyspace Profile to Model” on page 1-4.

¢ [f required, specify Polyspace configuration options in the Polyspace
verification environment. See “Configuring Verification Options” on page
1-10.

® Specify the include path to your operating system (environment) header
files and run verification. See “Running a Verification” on page 1-13 and
“Monitoring a Verification” on page 1-15.

® View results, analyze errors, and locate faulty code within model. See
“Viewing Polyspace Results” on page 1-16 and “Locating Faulty Code in
Rhapsody Model” on page 1-17.
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Adding Polyspace Profile to Model

Before you try to access Polyspace features, you must add the Polyspace
profile to your model :

1 In the Rhapsody editor, select File > Add Profile to Model. The Add
Profile to Model dialog box opens.

2 Navigate to the folder
Polyspace_Install\polyspace\plugin\rhapsody\profiles\Polyspace.

3 Select the file Polyspace.sbs. Then click Open.

Now, if you right-click a package or file, you see Polyspace features in the

context menu.
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Adding Polyspace Profile to Model
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Polyspace Verification is also available from the Tools menu.
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Note The 64-bit version of the Polyspace product does not support the Back
to model command with the 32-bit IBM Rational Rhapsody product.

To install the 32-bit Polyspace version, from a DOS command window, run
the following command:

DVD\Installer32bits\Windows\Disk1\InstData\VM\Polyspace.exe




Accessing Polyspace Features

Accessing Polyspace Features
To access Polyspace features in the Rhapsody editor:
1 Open the model that you want to verify. For

example, psdemos_uml link_airbag.rpy in
Polyspace_Install/polyspace/plugin/rhapsody/psdemos.

Polyspace_Install is the location of the Polyspace installation folder.

@ IEM Raticnal Rhapsody Developer for C++ - psdemos_uml_link_airbag.rpy
File Edit View Code Layout Tools Window Help

==l |& ® | | dh G @ | X

[ 2 [CompleteSystem ~ | DefauttConfig

| | | @
=]

Entire Model View -

N @) psdemos_uml_link_airbag
{:l Components

{:l Packages

{:l Profiles

{:l Settings

#-{] Use Case Diagrams

2 In the Entire Model View, expand the Packages node.

3 Right-click a package, for example, AirBagFiles.
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You see the following Polyspace functions in the context menu:



Accessing Polyspace Features

* Polyspace Verification — Start verification. See “Running a
Verification” on page 1-13.

¢ Polyspace Help — Open help.

e Stop Polyspace Verification — Stop client-based verification. See
“Running a Verification” on page 1-13.

¢ Polyspace Spooler — Open Polyspace Queue Manager. See
“Monitoring a Verification” on page 1-15.

¢ Edit Configuration — Specify verification options. See “Configuring
Verification Options” on page 1-10.

* View Results — View verification results. See “Viewing Polyspace
Results” on page 1-16.

Note You must add the Polyspace profile to your model before you try
to access Polyspace functions. See “Adding Polyspace Profile to Model”
on page 1-4.
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Configuring Verification Options
To specify options for your verification:

1 In the Entire Model View, right-click a package or class, for example,
AirbagControl.

Entire Model View =

BD psdemaos uml link airbag
BD Components
&1 AirBagSystem
-3 Configurations
E CompleteSystem
{:I Packages
BEI AirBagsFiles
c‘fﬁ' Actors
) Dependencies
Events
L Links
{&a Object Model Diagrams

Bﬁ Objects

=

- Use Cases
EJ"-E External

2 From the context menu, select Edit Configuration. The Configuration
pane of the Polyspace verification environment opens.
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Configuring Verification Options

-~ Polyspace C:\Polyspace\Polyspace_Common'\Poly5pace... EI@
File Edit Window Help

Lg E|Seard1: - ,®|
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L2

Name Value Internal name
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----- Send to Polyspace Server = -ZErver
----- Add to results repository -add-to-results-repository
----- Keep all preliminary results files = -keep-all-files
----- Calculate code metrics 0 -code-metrics
El-Report Generation =
Report template name Developer -report-template
“-Qutput format RTF -report-output-format

[+ Target/Compilation

[#-Compliance with standards
[#-Polyspace inner settings
[
E

H--Predision/Scaling
H--Multitasking

3 Select options for your verification. In particular, you must specify the
following:

* Target operating system (-0S-target)
¢ Dialect (-dialect)

¢ Include Folders (-I) — Path to your operating system (environment)
header files.

Note Polyspace provides Linux® header files for C++ in include-gnu,
which is located within the Polyspace product folder. For example,

C:\Polyspace\PolyspaceForCandCPP_R2011b\Verifier\include\include-gnu

4 To save your options, in the top left corner, click the disk button.
For information on how to choose your options, see:

® “Analysis Option Reference” for Ada

1-11



1 Polyspace® UML Link™ RH User’s Guide

® “Analysis Options for C Code”
® “Analysis Options for C++ Code”
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Running a Verification

Running a Verification

To start a verification:

1 In the Rhapsody editor, select Tools > Polyspace Verification. The

software opens the Polyspace Verification dialog box.

~* Polyspace Verification

POLYSPACE

Coda Varlicaticn Products

Results folder: | PolyspaceResults\SRSControl_C
Verification mode: @) Class Expert (Main)

Class to verify: | SRSControl_C

Verify with (highlight dasses):

==l

Polyspace UML Link
Rhapsody-5.8.0.7 (R2011h)

La]

Deselect Al

CrashSensor_C
AirbagControl_C

/| 5end to Polyspace server

Note Before starting a verification, make sure that the generated code

for the model is up to date.

2 In the Results folder field, specify a location for your verification results.

3 Select the Verification mode:

e (Class — Select a specific class from the Class to verify drop-down list.
In addition, underVerify with (highlight classes), you can select other
classes from the displayed list, for example, CrashSensor_C.

¢ Expert — The software verifies code according to the Generate a main
(-main-generator) options that you specify.
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4 If you want to run the verification on your Polyspace server, select Send to
Polyspace server.

5 Click Run. You see verification messages on the Log tab of the Rhapsody

editor.

Zllpun Verification

Argqument
Argument
Argument
Argument
Argqument
Argument
Argument
Argument
Argqument

0:

1
2
3
4:
5
[
7
-]

'-rtebase-dir’

'C:\Polyspace\PolyspaceForCandCPP R2011b\Verifieribin’

'-3ilent’

'-call-from-ide’

'rhapsody”’

1_efgt

'C:\Polyspace\Polyspace_Common' FolySpacelUMLLink\psdemos'\CompleteSystem C++.cig’
'-opticns-to-overwrite"!
'C:\Polyspace\Polyspace Common’\ PolySpaceUMLLink\psdemos\ps_automatic options.txt’

<polyspace-cpp R2011b FID19320 PEID1S320>

Polyspace verification of psdemos_uml_link airbag project.
Starting at 06/23/2011, 18h07.

Options used with Verifier:
-polyspace-wersion=CC-8.2.0.5 (R2011b)
-from=scratch

-date=23/06/2011

\Lagl.v{' Check Model I}\'Build f:\ Configuration Management .}\ Animation fn'r

If your verification is client-based, you can stop your verification. In the
Entire Model View, right-click, for example, a package or a class. From the
context menu, select Stop Polyspace Verification.

To stop a verification on the Polyspace Server, use the Polyspace Queue
Manager. See “Monitoring a Verification” on page 1-15.



Monitoring a Verification

Monitoring a Verification

If your verification is client-based, you can observe progress on the Log tab of
the Rhapsody editor.

Z||pun Verification -
Argument 0: '-rtebase-dir’

Argument 1l: 'C:\Polyspace‘\PolyspaceForCandCPE R2011b\Verifier\bin'

Argument 2: '-silent”

Argument 3: "-call-from-ide'

Argument 4: 'rhapsody’

Argument 5: '-cig'

Rrgument &: 'C:\Polyspace‘\Polyspace_Common'PolySpaceUMLLink\psdemos\CompleteSystem C++.cig’
Argument 7: '-opticns-to-overwrite!

Argqument &: 'C:\Polyspace‘\Polyspace Common\PolySpaceUMLLink\psdemos'\ps_automatic options.txt'

<polyspace-cpp R2011b FID19320 PEID1S320>

Polyspace verification of psdemos_uml_link airbag project.
Starting at 06/23/2011, 18h07.

Options used with Verifier:

-polyspace-wersion=CC-8.2.0.5 (R2011b)

-from=scratch

-date=23/06/2011 -
\Lagl.v{' Check Model I}\'Fjuilcl f:\ Configuration Management .}\ Animation fn'r

If your verification is running on a Polyspace Server, in the Entire Model
View, right-click, for example, a package or a class. From the context menu,
select Polyspace Spooler to display the Polyspace Queue Manager (or
Spooler). Use the Polyspace Queue Manager to manage jobs running on any
Polyspace Server.

For more information, see:

e “Verification Job Management” for Ada

® “Verification Job Management” for C/C++
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Viewing Polyspace Results

To view results from the last completed verification, in the Entire Model
View, right-click, for example, a package or a class. From the context
menu, select View Results. The Polyspace verification environment opens,
displaying results in the Results Manager perspective.

For more information on Polyspace verification results, see:

e “Run-Time Error Review” for Ada

e “Run-Time Error Review” for C/C++

Declarations for C Functions Without Arguments

By default, Rhapsody generates declarations for functions without any
parameters, using the form:

void my_function()

rather than:

void my_function(void)

This can result in the following Polyspace compilation error:

Fatal error: function 'my_function' has unknown prototype.

To avoid this problem, in Rhapsody, at the project level, set the property
C_CG::Configuration: :EmptyArgumentListName to void.
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Locating Faulty Code in Rhapsody Model

To identify the faulty code within your Rhapsody model using Polyspace
verification results:

1 In the Results Manager perspective of the Polyspace verification
environment, navigate to an error, for example, a non-initialized variable
at line 102 of Airbag Control C.

2 In the Source pane, right-click the error. From the context menu, select
Back to model.

=

AirbagControl.cpp 4 F B
91 !

9z

93 ®o=E:

94

a5 FrE]

96} =
a7 =
93 woid AirbagControl_C::ReadEntry(] {

99 //#[ operation ReadEntry()

100 int new_altitude;

101

loz2 ArmedEntry (new altitude)

103 if (mew altitude == tru % packto model

ig: i sourrent data = 100 Print View - Source code AirbagControl.cpp

106 1 Search "trug” in current source Ctrl+F
107 else Search "true” in all sources

108 { )

109 B *ourrent data = 1000 Gotolline Sl
110 } %= Open Source File

— Add Pre-Justification to Clipboard

112 f7#] . .

113 1 Create Duplicate Code Window -
< T b

Tip For the Back to model command to work, you must have your
Rhapsody model open.

The Back to model command works best when the Polyspace check is
enclosed by the tags //#[ and ]#//.
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The software locates the faulty code within your Rhapsody model.
Depending on the Rhapsody configuration, the faulty code appears either
in a dialog box or in the code view.

Primitive Operation : ReadEntry in AirbagControl - (8]

General I Description | Implementation |Arg|.|ments | Relations | Tags | Pmpertiesl

void ReadEntryl)

int new_altitude; -

m

*current_data = 100;

else
{
*current_data = 1000;

Locate QK

Note The 64-bit version of the Polyspace product does not support the
Back to model command with the 32-bit IBM Rational Rhapsody product.

To install the 32-bit Polyspace version, from a DOS command window,
run the following command:

DVD\Installer32bits\Windows\Disk1\InstData\VM\Polyspace.exe




Template Configuration Files

Template Configuration Files

In this section...

“Using Template Configuration Files” on page 1-19

“Default Configuration Options” on page 1-19

Using Template Configuration Files
The first time you perform a verification, the software
copies a template, Polyspace configuration file, from
Polyspace _Install/polyspace/plugin/rhapsody/etc/template_language.cfg
to the project folder. The software also renames the copy
model language.cfg, where:
® model is the name of your model
® Janguage is the name of the language that the model targets, that is, C,
C++, or ADA

You can update the template .cfg file by one of the following means:

e Editing it through the Polyspace verification environment

¢ Double-clicking the file in a Windows® Explorer window

® Replacing the template file with a copy of the .cfg file from a Rhapsody
model folder

You can then share a configuration among project members and use the
configuration with other projects.

Default Configuration Options

The template_language.cfg XML files specify the default option values
for code verification.

The file template_Ada.cfg is:

<?xml version="1.0" encoding="UTF-8"?7>
<polyspace_project name="template_cfg" language="Ada 95" author="polyspace"
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version="1.0" date="08/04/2011" path="file:/C:/Polyspace/Polyspace_Common
/Rhapsody/PolyspaceUMLLink/etc/template ADA.cfg">
<source>
</source>
<include>
</include>
<module name="Verification_1" isactive="true">
<source>
</source>
<optionset name="template_cfg" isactive="true">
<option flagname="-0S-target">no-predefined-0S</option>
</optionset>
</module>
</polyspace_project>

The file template C.cfg is:

<?xml version="1.0" encoding="UTF-8"?>
<polyspace_project name="template_cfg" language="C" author="polyspace"
version="1.0" date="08/04/2011" path="file:/C:/Polyspace/Polyspace_Common
/Rhapsody/PolyspaceUMLLink/etc/template_C.cfg">
<source>
</source>
<include>
</include>
<module name="Verification_1" isactive="true">
<source>
</source>
<optionset name="template_cfg" isactive="true">
<option flagname="-0S-target">no-predefined-0S</option>
<option flagname="-allow-undef-variables">true</option>
<option flagname="-respect-types-in-fields">true</option>
<option flagname="-respect-types-in-globals">true</option>
</optionset>
</module>
</polyspace_project>

The file template C++.cfg is:

<?xml version="1.0" encoding="UTF-8"7?>
<polyspace_project name="template_cfg" language="C++" author="polyspace"
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version="1.0"

date="08/04/2011" path="file:/C:/Polyspace/Polyspace_Common

/Rhapsody/PolyspaceUMLLink/etc/template C++.cfg">

<source>
</source>
<include>
</include>

<module name="Verification_1" isactive="true">

<source>
</source>

<optionset name="template_cfg" isactive="true">

<option flagname="-D">[OM_NO_FRAMEWORK_MEMORY_MANAGER]</option>
<option flagname="-0S-target">no-predefined-0S</option>
<option flagname="-allow-undef-variables">true</option>
<option flagname="-dialect">gnu</option>
<option flagname="-respect-types-in-fields">true</option>
<option flagname="-respect-types-in-globals">true</option>
<option flagname="-target">i386</option>
</optionset>
</module>

</polyspace_project>
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